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INTRODUCTION

Thank you for choosing Wuala Business to manage and share your
company's data. Wuala by LaCie gives you access to your documents
from any computer or mobile device with a connection to the internet.
You and your team members can view files in the office, at home, or on
the go. No matter how your company works on documents stored on
Wuala, you can rest assured that your data is safe from unauthorized
access. Wuala uses high-level encryption technologies AES, RSA, and SHA to guarantee that critical files are
secure and that a Wuala password never leaves the computer. Only your team members with a login and
password can view and edit files. Even LaCie, as the service provider, cannot see one byte of your data.
This manual will help you create your Wuala Business account and explain its features. For additional questions
on usage, please consult the Getting Help page or Wuala Frequently Asked Questions.
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MINIMUM SYSTEM REQUIREMENTS

COMPUTER

Latest version of:■

Windows® XP, Windows Vista®, Windows 7, or Windows 8■

Mac® OS X 10.6, 10.7, or 10.8■

Linux 2.6 or later■

Internet access (broadband recommended)■

Web browsers: Internet Explorer™ 7.0 / 8.0 Firefox™ 3.0, Safari™ 3.0, or Chrome 2.0 or higher■

Java 6 (also referred to as version 1.6)■

Note on Java: At the time of this writing, Java 7 is not recommended for use with Wuala.

MOBILE

iOS 5.0 or later■

Android 2.2 or later■
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CREATE A NEW ACCOUNT

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.

PERSONAL AND BUSINESS WUALA STORAGE

All Wuala Business users must have personal Wuala storage, including the administrator. Please note that Wuala
personal storage is never confused with your Wuala Business storage since they remain separate (see Get
Familiar with the Wuala Interface). Additionally, all Wuala users receive 5GB of free secure cloud storage so your
team members will experience enhanced data collaboration both at work and at home.
Existing Wuala Users: Go directly to Configure Your Wuala Business Storage to get started.
New Wuala Users: Follow the instructions below to install the Wuala application on your computer and
configure Wuala personal storage.

Important info: Coworkers that already have Wuala personal storage should provide the Business storage
administrator with their Wuala contact names. Please note that the administrator can create new Wuala
personal storage for coworkers who have yet to join.

WUALA FOR YOUR COMPUTER

Please follow the instructions for downloading and installing Wuala according to your operating system:
Windows■

Mac■

 

http://manuals.lacie.com/en/manuals/wuala-business/gui
http://manuals.lacie.com/en/manuals/wuala-business/gui
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Download and Install Wuala on Windows

To download Wuala onto your computer, please open your preferred browser and go to www.wuala.com.
Click on Download.1.

Depending upon the browser, you may receive a prompt asking if you wish to download or run the installer.2.
Wuala recommends that you choose Run or its equivalent.
Once the installer has downloaded, the Welcome to Wuala Setup window will appear. Click Next to follow the3.
installer prompts. If you are prompted to add drivers such as CBFS update, please follow the installation
directions to completion. You may be asked to reboot your computer.

http://www.wuala.com
http://manuals.lacie.com/_detail/products/wuala-business/install/wuala_download_explorer.png?id=en:manuals:wuala-business:printable
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First Launch - Wuala on Windows

Launch Wuala from All Programs/Programs.1.
A prompt will ask you to sign in or create a new account. If you already have an account, select Sign in with2.
existing account and skip to Configure Your Wuala Business Storage. If you do not have an account with
Wuala, click Create free Account. An email will be sent confirming your Wuala account.

Fill in all the applicable fields. Please note that the Promo code is not the same as the Wuala3.
Business Starter Code. Check the box next to I have read and agree with the Terms of Service then click
Create Account.

http://manuals.lacie.com/en/manuals/wuala-business/business-group
http://manuals.lacie.com/_detail/products/wuala-business/install/first_launch_win_01.png?id=en:manuals:wuala-business:printable
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Your personal account has been created. Go to Configure Your Wuala Business Storage to get started with4.
your company's Wuala Business Account.

http://manuals.lacie.com/_detail/products/wuala-business/install/first_launch_win_03.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/en/manuals/wuala-business/business-group
http://manuals.lacie.com/_detail/products/wuala-business/install/first_launch_personal_account.png?id=en:manuals:wuala-business:printable
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Notes on installation:

If Wuala does not open immediately, please launch the application again from All Programs/Programs.■

At the prompt, select Sign in with existing Account then enter the login and password you created.

A second update for Windows Explorer Integration may be required. If you are prompted, please click■

Setup to complete the installation steps and reboot your computer.

 

http://manuals.lacie.com/_detail/products/wuala-business/install/first_launch_win_10b.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/install/first_launch_win_12.png?id=en:manuals:wuala-business:printable
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Download and Install Wuala on Mac

To download Wuala onto your computer, please open your preferred browser and go to www.wuala.com.
Click on Download to download Wualainstaller.dmg onto your computer.1.

Open the Wualainstaller.dmg file to begin the installation.2.
Wuala requires OSXFUSE to run properly on your Mac. If it is not already installed, please click twice on3.
OSXFUSE.pkg to begin the installation.
Follow the installation steps for OSXFUSE. You may be prompted for the administrator's login and password.4.

 

http://www.wuala.com
http://manuals.lacie.com/_detail/products/wuala-business/install/installer_mac_01.png?id=en:manuals:wuala-business:printable
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First Launch - Wuala on Mac

Configure your Wuala personal storage:
From the desktop, select Go > Applications and click twice on the Wuala application.1.
You may receive a Mac OS prompt. Please select Open to continue.2.
A prompt will ask you to sign in or create a new account. If you already have an account, select Sign in with3.
existing account and skip to Configure Your Wuala Business Storage. If you do not have an account with
Wuala, click Create a new account.
Fill in all the applicable fields. Please note that the Promo code is not the same as the Wuala4.
Business Starter Code. Check the box next to I have read and agree with the Terms of Service then click
Create Account.

Your personal account has been created. Go to Configure Your Wuala Business Storage to get started with5.
your company's Wuala Business Account.

http://manuals.lacie.com/en/manuals/wuala-business/business-group
http://manuals.lacie.com/_detail/products/wuala-business/install/first_launch_mac_04.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/en/manuals/wuala-business/business-group
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Wuala Business: User Manual 13

GET FAMILIAR WITH THE WUALA INTERFACE

The default Wuala interface has two columns with two primary panes.

A - Toolbar■

B - Wuala account directory■

C - Folders and files■

D - Status bar■

TOOLBAR

The icons represent:
Back and Forward arrows■

Return arrow to the master directory (User, Contacts, Groups)■

View folders as Thumbnails or Details■

Thumbnails

Details

Click Add to create a new Folder, Backup, Sync, Group, or Company.■

http://manuals.lacie.com/_detail/products/wuala-business/start/two_panes.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/en/manuals/wuala-business/gui#toolbar
http://manuals.lacie.com/en/manuals/wuala-business/gui#wuala-account-directory
http://manuals.lacie.com/en/manuals/wuala-business/gui#folders-and-files
http://manuals.lacie.com/en/manuals/wuala-business/gui#status-bar
http://manuals.lacie.com/_detail/products/wuala-business/start/toolbar_forward_backward.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/toolbar_master_directory.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/toolbar_thumbnails.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/toolbar_details.png?id=en:manuals:wuala-business:printable
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WUALA STORAGE DIRECTORY

The first column from the left lists your directory of Wuala accounts and groups:
Notifications - Recent updates to files are available for review.■

Personal folders and files - Users receive 5GB of free secure cloud storage with the option to upgrade. This■

storage remains separate from the Company storage listed in Groups below.

Company - Your Company storage and Business Groups. In the example below, the name of the Company is■

CloudCentre.

http://manuals.lacie.com/_detail/products/wuala-business/start/toolbar_add.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/personal_storage.png?id=en:manuals:wuala-business:printable
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Contacts - Look at files that your Wuala contacts want to share with you.■

Groups - Access files shared by other Wuala users.■

Notes:

When first creating an account, you may only find the folders and files within the first column. Contacts■

and Groups will appear once you have added them to your account.
A single Wuala Business Starter Code includes 100GB with the option to upgrade.■

 

http://manuals.lacie.com/_detail/products/wuala-business/start/business_storage.png?id=en:manuals:wuala-business:printable
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FOLDERS AND FILES

The second column from the left gives you a larger perspective of your folders and files.

Folders are colored by access rights:
Yellow - Private folder that can only be accessed by the user.■

Blue - Public folder that the user has opened for anyone to access. It can be found on a standard internet■

search engine and its contents are available to everyone.
Red - Shared folder with access to a select group. The user has chosen to share files in the folder with a■

limited amount of people. Please note that folders within groups are red since they are shared.

A folder can have an icon that indicates it is being used for:
Backup■

Sync■

http://manuals.lacie.com/_detail/products/wuala-business/start/folder_column.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/folder_color.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/backup_overlay.png?id=en:manuals:wuala-business:printable
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http://manuals.lacie.com/_detail/products/wuala-business/start/sync_overlay.png?id=en:manuals:wuala-business:printable
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STATUS BAR

The icons represent:
A green LED indicates the user is online. The LED will turn red if internet connectivity is lost.■

Upload and Download progress bars■

File path and size■

Storage capacity used and available; link to add more storage and users to your account■

 

http://manuals.lacie.com/_detail/products/wuala-business/start/status_led.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/status_upload_download.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/status_file_path.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/start/status_storage.png?id=en:manuals:wuala-business:printable
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The Status Pane storage capacity will differ according to the storage being accessed by the user:
■
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CONFIGURE YOUR WUALA BUSINESS STORAGE

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.

WUALA BUSINESS: YOUR COMPANY

Your Wuala Starter Code allows you to build a profile for your team. Your Wuala business, called a Company,
features 100GB of secure online storage and supports up to five Wuala Business Groups. A Business Group may
be thought of as a single volume that is contained within your Wuala Company. Since they act as the storage
volumes, you will use the Business Groups to host your folders and files. A single Business Group supports up to
five users, including the administrator.

Example Wuala Company Account

CloudCentre has decided to use Wuala Business to enhance its digital workflow. The administrator, Davidadmin,
already has personal Wuala storage and will now create a Wuala Company for CloudCentre. Once the Company
is created, Davidadmin can add up to five Wuala Business Groups to store the CloudCentre's data. The Business
Groups are expected to optimize data organization and collaboration. For example, Business Groups will be
assigned as:

CloudGroup-01 to store all documents that pertain to the general business.■

CloudCentre-Photos to store the company's image library.■

CloudCentre-Creative to store all advertising and artwork.■

CloudCentre-Accounting to store invoices for accounts payable/receivable.■

CloudCentre-Human Resources to store files critical to managing personnel.■

Of course, not all members of the company require access to all of CloudCentre's Business Groups. Therefore,
Davidadmin gives the Human Resources department access to its own Business Group, the Accounting team
access to its own Business Group, etc. Each Business Group supports up to five users, including the
administrator. This means that an administrator can invite more than five users to join the Company Account
since each Business Group will be accessed by different users per department.

YOUR COMPANY

Wuala Business is easy to integrate into your company's workflow. Before getting started, please confirm that:
Wuala is installed on your computer and that you have configured your Wuala personal storage. If you do not■

have Wuala storage, please go to Create a New Account.
You have a Wuala Business Starter Code. To order a Wuala Business Starter Code, please go to Wuala■

Business Starter Code. Details on pricing are available at Wuala Business.

Wuala Business Trial Offer: Wuala offers a special 30-day trial pack if you would like to try our secure
online storage before purchasing the Business Starter Code. Once you and your team have seen how easy it

http://manuals.lacie.com/en/manuals/wuala-business/install-new
http://www.wuala.com/business/buy
http://www.wuala.com/business/buy
http://www.wuala.com/business
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is to work together on Wuala, we are confident that you will be hooked! Visit Wuala Business Trial for more
information.

Add Company

Log on to your Wuala account.1.
Select Add > Company.2.

Windows

Mac

Enter your Wuala Business Code and Company Name. The code is case insensitve and dashes are not3.
required. NOTE: The Company Name cannot be changed once it has been accepted.

http://wuala.com/en/business/try
http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_01_win.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_01_mac.png?id=en:manuals:wuala-business:printable
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A prompt will ask you to create a Business Group for your company. The Business Group is the volume that4.
hosts your company's folders and files on Wuala. Click Add Group.

Enter a name for your Wuala Business Group. NOTE: The Company Name cannot be changed once it5.
has been accepted.

http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_02.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_03.png?id=en:manuals:wuala-business:printable
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Your Wuala Business Group is now ready to use. See Manage Your Wuala Business Storage and Add/Manage6.
Members to learn how to administer and add colleagues to your Wuala Business Account.

Your Business Group within the Manage Company window

http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_04.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/en/manuals/wuala-business/manage
http://manuals.lacie.com/en/manuals/wuala-business/members
http://manuals.lacie.com/en/manuals/wuala-business/members
http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_05.png?id=en:manuals:wuala-business:printable
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Your company account is available below your personal account

Note on the Wuala Business Group Administrator: By default, the person who creates the Company
and Business Group is the administrator. In addition to full access to all data stored within the Business
Group, an administrator will add users and manage their access rights.

Note on Groups: A single Wuala Business Code supports up to five groups. You may purchase additional
groups and users at Wuala Business.

 

http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_06.png?id=en:manuals:wuala-business:printable
http://www.wuala.com/business/buy
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MANAGE YOUR WUALA BUSINESS STORAGE

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.
There are two ways to access the Manage Company window:

Click the Manage link on the status bar at the bottom of the window.■

Right click on the Company Name to choose Manage Company….■

 

http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_01a.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_01b.png?id=en:manuals:wuala-business:printable
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The Manage window includes four tabs:
■
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http://manuals.lacie.com/en/manuals/wuala-business/manage#overview
http://manuals.lacie.com/en/manuals/wuala-business/manage#overview
http://manuals.lacie.com/en/manuals/wuala-business/manage#overview
http://manuals.lacie.com/en/manuals/wuala-business/manage#overview
http://manuals.lacie.com/en/manuals/wuala-business/manage#overview
http://manuals.lacie.com/en/manuals/wuala-business/manage#overview
http://manuals.lacie.com/en/manuals/wuala-business/manage#groups
http://manuals.lacie.com/en/manuals/wuala-business/manage#groups
http://manuals.lacie.com/en/manuals/wuala-business/manage#groups
http://manuals.lacie.com/en/manuals/wuala-business/manage#groups
http://manuals.lacie.com/en/manuals/wuala-business/manage#groups
http://manuals.lacie.com/en/manuals/wuala-business/manage#groups
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#members
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage
http://manuals.lacie.com/en/manuals/wuala-business/manage#storage


Wuala Business: User Manual 30

OVERVIEW

Review your company's:
Used/available storage■

Total members per Business Group■

Total members■

GROUPS

http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_02.png?id=en:manuals:wuala-business:printable
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Review the total users and storage available to your Business Group(s):
Click on the Manage Group icon (wrench) for additional details on the Business Group. See Manage a■

Business Group for more information on the Manage Group settings.

Click on the X to delete the Business Group. Please note that:■

Deleting your Business Group will remove all the data it contains.■

Deleting a Business Group is a permanent action.■

http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_03a.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/en/manuals/wuala-business/manage-group
http://manuals.lacie.com/en/manuals/wuala-business/manage-group
http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_03c.png?id=en:manuals:wuala-business:printable
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Click Add Group to create a Business Group. A single Wuala Business Code supports a maximum of five■

Business Groups. Each Business Group can have up to five members, including the administrator.

http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_03b.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/group/create_company_03.png?id=en:manuals:wuala-business:printable
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MEMBERS

Use this tab to add members to your Wuala Business storage. See Add/Manage Members for more information
on managing Wuala Business users.

STORAGE

http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_company_04.png?id=en:manuals:wuala-business:printable
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Select this tab to review the used/available capacity of your Business storage. See Upgrade your Business
Storage: Add Storage, Users, and Groups and Renew your Wuala Business Storage or Move from a Trial Account
to a Full Account for instructions on how to:

Add capacity to your Business storage■

Add users and Business Groups■

Renew a Wuala Business Code■

Move from a trial to a full account■

 

http://manuals.lacie.com/_detail/products/wuala-business/manage/manage_group_03a.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/en/manuals/wuala-business/add-storage
http://manuals.lacie.com/en/manuals/wuala-business/add-storage
http://manuals.lacie.com/en/manuals/wuala-business/renew
http://manuals.lacie.com/en/manuals/wuala-business/renew


Wuala Business: User Manual 35

MANAGE A BUSINESS GROUP

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.

There are three ways to access the Manage Group window:
Select File > Manage Group…■

Right click on the Business Group Name to choose Manage Group….■

Click the Manage Group icon (wrench) within the Manage Company settings (Group tab).■
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The Manage Group window includes three tabs that allow the administrator to manage access rights and
storage for a specific Business Group.

Roles■

Access■
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Storage■
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ROLES

Review and adjust the definitions of roles assigned to Members of the Wuala Business storage. The default
defintions are:

Member Moderator Administrator

Read/Write Access Yes Yes Yes

Invite New Members No Yes Yes

Adjust Group Settings No No Yes

The administrator can adjust Role default settings.
Edit the names of the Roles to match your business. For example, Member to Intern, Moderator to Writer, and■

Administrator to Chief. See the image below:

Select or deselect permissions for one or more Roles. For example, give Members the right to Invite new■

members by checking the box.
Reassign the Default Role for new members from Member to Moderator.■
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ACCESS

Give clients and colleagues access to files stored in the Business Group:
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Check the box next to Web access through secret weblink:1.
Select the appropriate radio button. You can send a link that will:2.

Grant access to files.■

Grant access to files and membership to the Business Group. Wuala recommends using this option only■

with someone who has a personal Wuala account (see Access to files and membership to the Business
Group).
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Click OK. Note: You must accept the link by selecting OK.3.
Right click on the Business Group to select Copy Link.4.

Paste the link to an email meant for your client, colleague, or collaborator.5.
The recipient will have access to all the files in your Business Group.6.

Personalize Your Weblink

To personalize your secret weblink:
Select the pencil icon.1.
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In the Key field, type the key word you wish to use for your weblink. In the example below the administrator2.
has used the name of the company.

The weblink will reflect your revisions.3.
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Click OK. Note: You must accept the link by selecting OK.4.
Right click on the Business Group to select Copy Link.5.

Paste the link to an email meant for your client, colleague, or collaborator.6.
The recipient will have access to all the files in your Business Group.7.

Access to files and membership to the Business Group

By selecting the option to grant membership to your Business Group, the recipient can both enjoy the Business
Group files as well as collaborate with your team. To use this option in the Access tab, Wuala recommends that
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recipients:
Already have a personal Wuala account.■

Follow the directions below.■

Steps to join the Wuala Business Group using a Weblink

Important note for Mac users: Java must be enabled on your computer.

The recipient of the Wuala weblink must follow the steps below in the exact order:
Log onto Wuala using a personal account1.
Open the email with the weblink and click on it to launch your default internet browser.2.
Click on the Open in Wuala button on the top right of the browser.3.

The Wuala website will open and search for Java on your computer. You may receive a message asking if you4.
wish to run Java. Allow Java to run if you wish to continue.

An option to Join the Business Group will be available within Wuala.5.
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STORAGE

This tab provides a quick summary of the:
Total members of the Business Group■

Wuala Subscriptions■

Percentage of company storage used■

One-time purchases■

Note on One-time purchases: Codes acquired from Wuala for secure cloud storage capacity, Business
Groups, and Members. All codes associated with your Wuala Business storage will be listed here. Dates of
purchase and expiration are available for reference.

Click Details in the Storage tab to review the storage capacity used by this and other Business Groups
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associated with your Wuala Business storage. Administrators for each Business Group are also listed.
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ADD/MANAGE MEMBERS

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.
Each Wuala Business Group can have up to five members, including the administrator. Each member has a
defined Role with specific rights (see Roles for member definitions).

ADD MEMBERS TO THE BUSINESS GROUP (RECOMMENDED)

As the creator of the Wuala Business storage, the first user is the administrator. This leaves four available
places within each Business Group. Invitations to join the company may be sent to existing Wuala users or to
users that have yet to join.

There are three options for inviting new members:
Members Tab (Recommended) - Invite your colleagues to join the Wuala Company storage. This option is■

intuitive and very helpful when inviting users who do not have a Wuala personal account.
Invite Members - Invite users who already have Wuala personal storage. (Alternative to the steps provided in■

Members Tab.)
Access (Advanced Wuala users) - Send a weblink with the option to join the Business Group. The user must■

have a personal Wuala account.

Members Tab - Create a new Wuala Account

Follow the steps below if a user does not have Wuala personal storage:
Launch Wuala and right click on your Company name to select Manage Company.1.

Choose the Members tab.2.
Click on Create New User.3.
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Fill out the required fields.4.

A Wuala user name will be created automatically if the box next to generate remains checked. You can5.
deselect generate to manually create a user name. Click Create.
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The user will receive a confirmation email that includes instructions on account activation. Once the account6.
has been activated by the user, a link to join the Business Group will be available in Groups > Group
Invitations.

The user will have access to the Company's Business Group(s) once he clicks Accept (see Accepting a Wuala7.
Invitation: User).

Members Tab - Invite an existing Wuala user

Important info: To join a Company Business Group, users must have a personal Wuala account. Therefore,
it is recommended that coworkers provide the Wuala Company storage administrator with their Wuala
contact name so that he can add them to his Contact list.
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Launch Wuala and right click on your Company name to select Manage Company.1.

Choose the Members tab.2.
Click on Invite Existing Users.3.

Click on Find Contacts.4.
Enter the Wuala user name then click Add to contacts. Consult with the user if you do not know his Wuala5.
name.
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Review the prompt regarding your contact(s) then select Close.6.
Make certain that the check box next to the new user is selected before clicking OK.7.

Select the Company Business Group(s) you wish the user to access then click OK.8.
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The user is now listed as a member of your Company.9.
To complete the process, the user should accept membership the next time he logs on to his personal10.
Wuala account (see Accepting a Wuala Invitation: User).

Accepting a Wuala Invitation: User

Important info: Users do not have to worry about the privacy of their own data when joining Company
storage. All data stored on personal storage is separate from the data kept in the Business Group.

Once an invitation has been sent by the Wuala Company storage administrator, the user should log in to his1.
account.
In most instances, the user will see the invitation upon login. If it does not appear within the welcome window,2.
click on Groups.

Click Accept to join the Company storage. The Company name will appear in the left column.3.
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Invite Members: Wuala Contact

This is an alternative to the steps described in Members Tab - Invite an existing Wuala user.

Important info: To join a Company Business Group, users must have a personal Wuala account. Therefore,
it is recommended that coworkers provide the Wuala Company storage administrator with their Wuala
contact name so that he can add them to his Contact list.

Right click on the Business Group to select Invite Members > Invite Contacts…1.

To search for one or more contacts to add to the Business Group, click on Find contacts.2.
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Enter the user or Wuala name in the search field then click Search.3.
Once the user is found, check the box next to the name and click Add to contacts. A pop-up window will let4.
you know that the user has been added.

From your list of contacts, you may choose specific users by checking the boxes next to their names or invite5.
all your contacts to the Business Group by selecting All of your current contacts.

To complete the process, the user should accept membership the next time he logs on to his personal Wuala6.
account (see Accepting a Wuala Invitation: User).
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REMOVE A USER

You may remove a member from the Company. Please note that the user's Wuala account will not be deleted.
Right click on your Company name to select Manage Company… then click on the Members tab.1.
Click on the X in the same row as the user you wish to delete.2.

A prompt will ask you to confirm the action. Click Yes to remove the user from the Company.3.
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SHARE GROUPS OR FOLDERS USING SECRET WEBLINKS

Wuala offers a simple and secure way to share files with others. Follow the directions below to send secure
weblinks to folders and files to clients, colleagues, friends, and family.

SHARE A BUSINESS GROUP

You can share the entire contents of a Business Group via a secure weblink.
Right click on the group and select Manage Group….1.

Choose the Access tab then click on the radio button next to The weblink grants access to files.2.
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Click OK to close the window and confirm weblink sharing.3.
Right click on the Business Group to select Copy Link then paste it to an email meant for your recipients.4.
Please note that the recipients will have access to all contents within the Business Group.
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CUSTOMIZING THE BUSINESS GROUP WEBLINK

You can personalize or revise the weblink to suit your needs.
Right click on the Business Group to select Manage Group > Access.1.
Enable the weblink then click on the pencil icon.2.

Enter the new weblink reference in the Key field. Wuala suggests making it as brief as possible. The text will3.
appear at the end of the weblink.

Click OK to accept the new weblink.4.
Click OK to close the window and confirm weblink sharing.5.

SHARE FOLDERS

Right click on the folder to select Share this Folder > By Secret Weblink.1.
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A prompt will present you with the link to copy. If the link meets your needs, you can click OK to confirm2.
weblink sharing. See the next step if you prefer to personalize the weblink.

(Skip this step if you do not wish to personalize the weblink). Click on Advanced to reveal the Secret Key.3.
Enter the new weblink reference in the Key field. Wuala suggests making it as brief as possible. The text will
appear at the end of the weblink. Click OK to confirm weblink sharing.

Right click on the folder to select Copy Link.4.
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Paste the weblink to an email meant for people who will share the folder.5.
The recipients of the email can click on the link to download files via their web browser.6.

PROHIBIT SHARING
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In certain cases, the administrator may decide that sharing data with people outside of the group is
unnecessary or unwanted. Follow the directions below to prevent members of the group to share via weblink.

Right click on the Business Group to select Manage Group… > Access.1.
Deselect the check box next to The weblink grants access to files then click OK to confirm that you no longer2.
wish to share the Business Group with non-members.
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MOBILE ACCESS

Your Wuala Business Groups are accessible on compatible iOS and Android devices (see Minimum System
Requirements for compaatible mobile operating systems).

WUALA APP

The Wuala app is available at the iOS App Store and Google Play for Android. Download it on your compatible
mobile device to access files anywhere with a connection to the internet.

The Apple app store for iOS devices■

Google play for Android devices■

If you cannot find the Wuala app, please go to Wuala Mobile.

LOG ON AND ACCESS

On your mobile device, launch the Wuala app.1.
Enter your personal Wuala Username and Password.2.
Click on Groups to access your Wuala Company Business Group(s).3.
Select the Business Group you wish to access then choose the desired file(s).4.

To view our frequently asked questions regarding the Wuala mobile app, please visit Wuala for iOS Devices.

Note regarding file types: You may require third-party apps to view files.
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UPGRADE YOUR BUSINESS STORAGE: ADD STORAGE,
USERS, AND GROUPS

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.

ADD STORAGE AND USERS

Your Wuala Company Starter Code supports up to five Business Groups on 100GB of secure online storage. Each
Business Group can have up to five users, including the administrator. To add more Wuala storage capacity and
users, follow the instructions below.

Right click on your Company name to select Manage Company…1.
Select the Storage tab.2.
Click on the link Get more for upgrade options.3.

You will be directed to Buy Wuala Business. Enter your email address and select the amount of storage4.
capacity and/or users/groups you wish to add.
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Following your purchase, a new code will be sent to your email address. Enter the new code in the field5.
Redeem Wuala Business Code on the bottom of the Storage tab.

Enter the new code sent to your email address

Click Redeem to receive your upgrade.6.
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RENEW YOUR WUALA BUSINESS STORAGE OR MOVE
FROM A TRIAL ACCOUNT TO A FULL ACCOUNT

Wuala recommends that the administrator for your Business storage follows all instructions to create and
manage your Company on Wuala.
You will receive an email before the expiration date for your Wuala Starter Pack/Trial Code. To renew your
account or move from a trial account to a full account:

Go to Buy Wuala Business.1.
Enter your email address and check the box next to Starter pack. You also have the options to add Wuala2.
secure online storage and/or users/groups.

Following your purchase, a new code will be sent to your email address. Go to Manage Company >3.
Storage in Wuala to enter the new code in the field Redeem Wuala Business Code.
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Enter the new code sent to your email address

Click Redeem to receive your update. Your code is valid for one year.4.
 

http://manuals.lacie.com/_detail/products/wuala-business/manage/upgrade_03.png?id=en:manuals:wuala-business:printable


Wuala Business: User Manual 68

WUALA FEATURES OVERVIEW

Wuala provides secure, easy sharing of your business data in the cloud. You will also find important tools that
help you to collaborate with your coworkers while protecting everyone's data.

Feature Click to view

Create folders to share with the group. Create Folders

Add files for the group to share. Upload Files

Copy folders from your desktop to Wuala. Copy Folders

Download folders and files from Wuala to your computer or an external volume. Download

Delete and restore files. Delete and Restore Files

Share files and folders with others via secret weblink. Share

Building Your Wuala Contact List. Wuala Contacts

Backup folders to a Wuala personal account. Backup

Sync folders to multiple computers. Sync

Edit files within Wuala. Edit Files

Find earlier versions of documents. Versioning

Add more Business Groups to your Company Storage. Multiple Business Groups

Move backwards in time to grab earlier versions of folders and files using Time
Travel. Time Travel
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CREATE FOLDERS

Create folders to better organize the files your team stores on Wuala.
Right-click on the username or group to select Add Folder…1.

Enter the name for the new folder then click OK.2.
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UPLOAD FILES

While data can be stored on the root level of personal storage or a group, Wuala highly recommends that you
create folders to organize files uploaded to Wuala. To upload files to a folder:

Open a folder then right click to select Upload Files…1.

Browse in your computer to the folder with the files that you wish to upload to Wuala. You may choose to2.
upload one file or several.

Add one or several files

The file(s) will appear in the folder. Please note that upload times will vary based upon the speed of your3.
connection to the internet.
In the case of groups, all members can access the files uploaded by a single member.4.
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Another member logs onto Wuala

The upload files is available to everyone in the group

Note: Files may also be uploaded to Wuala using drag and drop or copy and paste.
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COPY FOLDERS

You may copy folders directly to your Wuala group.
Log onto Wuala and select your group.1.
Locate the folder(s) you wish to copy to Wuala. You can copy folders from internal hard drives, external hard2.
drives, or network volumes.
To upload the folder(s) to Wuala, drag it/them to the Wuala group.3.
The time to complete the upload will depend upon the amount of data stored in the folder(s).4.
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DOWNLOAD

Folders and files can be downloaded to your computer, an external hard drive, or a network volume.
Right click on the folder or file and select Download To Folder…1.

Download a file

Browse your computer to select the download location and click OK. The time to complete the download will2.
depend upon the amount of data stored in the folder(s) or the size of a file.
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DELETE AND RESTORE FILES

You can move folders and files to the trash for deletion. Files that have not been emptied from the trash may be
restored to the group storage.

Delete

Right click on the folder(s) or file(s) you wish to move to the trash and select Delete. You may also click on1.
the folder or file and choose the Delete button on your keyboard.

A prompt will ask you to confirm the action before moving the folder(s)/file(s).2.
If you wish to permanently remove data in the trash, right click on the trash icon to select Empty Trash.3.
Click Yes at the prompt to confirm.
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Restore

To remove folders or files in the trash:
Click twice on the trash icon to reveal its contents.1.
Right click on the folder or file you wish to keep and select Restore. The folder or file will be returned to its2.
original location on the group storage.
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Share Folders

Right click on the folder to select Share this Folder > By Secret Weblink.1.

A prompt will present you with the link to copy. If the link meets your needs, you can click OK to confirm2.
weblink sharing. See the next step if you prefer to personalize the weblink.

(Skip this step if you do not wish to personalize the weblink). Click on Advanced to reveal the Secret Key.3.
Enter the new weblink reference in the Key field. Wuala suggests making it as brief as possible. The text will
appear at the end of the weblink. Click OK to confirm weblink sharing.
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Right click on the folder to select Copy Link.4.

Paste the weblink to an email meant for people who will share the folder.5.
The recipients of the email can click on the link to download files via their web browser.6.

http://manuals.lacie.com/_detail/products/wuala-business/features/share-filefolder/share_filefolder_03a.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/features/share-filefolder/share_filefolder_04b.png?id=en:manuals:wuala-business:printable


Wuala Business: User Manual 78

 

http://manuals.lacie.com/_detail/products/wuala-business/features/share-filefolder/share_filefolder_04b.png?id=en:manuals:wuala-business:printable


Wuala Business: User Manual 79

WUALA CONTACTS

Add Wuala users to your Contact list.

Step 1: Adding a Contact

Open your Wuala account to select Tools > Find Contacts…1.
In the Find Contacts window, type the name of the user you want to add as a contact then click Search. You2.
may need to ask the contact for his Wuala username.

If the search result is correct, check the box next to the user name and click Add to contacts.3.
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A prompt will let you know that the contact has been sent a message indicating that you wish to add him to4.
your list. Click Close.

Step 2: Contact Accepts Invitation

Your contact will receive a prompt in Notifications indicating that you wish to add him as a contact. He should:
Open his Wuala storage and click Notifications on the left of the window.1.
He will see the request to be added as a contact. Click Accept.2.

By accepting, he will also add you to his list of contacts.3.

Step 3: Confirm Contact

You will receive a confirmation that the contact was successfully added to your list.
Click OK once you have read the message.1.
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Your coworker is now on your contact list.2.
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BACKUP

You may back up data from your computer's internal hard to your Wuala personal storage. At this time, Wuala
recommends that you do not back up data from an external or network hard drive to Wuala.

Important info: Please note that members of a Business Group cannot back up data to the Company
storage.

Backup Setup

Click on Add to select Backup…1.

Browse to the folder you wish to backup to Wuala. Note that clicking on the arrow next to Advanced opens2.
additional options to exclude certain files from the backup.
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Wuala will begin the backup. Note that folders marked for Wuala backup include the clock and circular arrow3.
icon.
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Manage Backup

To adjust the backup settings:
Click on the backup folder to choose the wrench icon.1.

The Backup Settings window allows you to change the backup interval as well as filter files.2.
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Note: Selecting the minus symbol will delete the backup. Provided that the user has not deleted them, the
original files will remain intact on their source storage.
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SYNC

Members of a business team and single users can have the latest versions of important documents on all their
computers:

Business Storage: A member of the team creates a Wuala Sync folder called Daily Action Plans on his■

computer. Each member of the same Business Group adds Daily Action Plans to their computers to receive
automatic updates and to add documents that they have created.
Personal Storage: A Wuala user can create a Sync folder called Legal Briefs on her computer. To access the■

same files in the office, she will log on to Wuala to add Legal Briefs on her work computer. Since Wuala will
upload/download the most recent content automatically to all Sync folders, she can leave the work laptop in
the office.

You may synchronize data from your computer's internal hard to Wuala storage. Wuala highly recommends that
you do not synchronize data from an external or network hard drive as it could delete files.

Create a Sync Folder

Sync folders and Wuala Business Users: Please make certain to highlight the applicable Wuala storage
before creating a Sync folder. For example, if the Sync folder is for personal use, select your personal
storage. If the Sync folder is for collaboration within your Company, select your Business Group.

Highlight the applicable Wuala storage for your
Sync folder

Click on Add > Sync…1.

http://manuals.lacie.com/_detail/products/wuala-business/features/sync/sync_01a.png?id=en:manuals:wuala-business:printable


Wuala Business: User Manual 88

Browse to the folder on your computer that you wish to sync. Note that clicking on the arrow next to2.
Advanced opens additional options to exclude certain files from the sync.
The sync folder has been added to the Wuala storage.3.

A check mark on the folder stored on on the source storage indicates that it is being synchronized with the4.
Wuala storage.

http://manuals.lacie.com/_detail/products/wuala-business/features/sync/sync_01b.png?id=en:manuals:wuala-business:printable
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Sync the folder on additional computers

Log on to Wuala to choose the storage that hosts the folder you wish to Sync (personal or business storage).1.
Right click on Sync folder to select Synchronize with this computer…2.

Note the location for the local sync folder on your computer then click OK.3.

The folder is now synchronized with the computer. Repeat the steps for each new computer.4.

Important info on Sync Folder Displacement: Wuala recommends using the default location on your
local computer for the Sync folder. Choosing an alternative folder will adjust the name of the Sync folder.
Additionally, the contents of the Wuala Sync folder will be mixed with the files in the existing folder on your
computer. To prepare a new location, you can create a folder with the same name as the Wuala Sync folder.
For example, create a folder called Daily Action Plans on your Desktop before attempting to add the Sync
folder.

 

http://manuals.lacie.com/_detail/products/wuala-business/features/sync/sync_alt_computer_02.png?id=en:manuals:wuala-business:printable
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Managing the Sync Folder

Adjust the file types you wish to Sync by right clicking on the folder to select Sync Settings…■

Choose files to exclude from Sync

Review the number of computers that have synchronized with the folder by selecting Tools > Sync■

Overview. You can also adjust settings within the Sync folder.
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EDIT FILES

Wuala can be used as the primary storage for your documents. Open and edit files within Wuala to reduce
frequent copying and pasting of data. By editing documents within Wuala, you can take advantage of Versioning.

Log into your Wuala account to find the file you wish to open. Right click on it and Wuala will present the1.
compatible applications on your computer.

Choose the application to open the file. You can work on the file and all revisions will be saved on Wuala.2.
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Note on available applications: Wuala empowers you to work on documents from the group storage.
Please note that the native application or a compatible program must be available on your local computer. If
Wuala cannot find a compatible program, you will be prompted to Choose Program…

 

http://manuals.lacie.com/_detail/products/wuala-business/features/edit-files/open_in_wuala_no_program.png?id=en:manuals:wuala-business:printable
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File System Integration

File system integration must be turned on to edit files within Wuala. Please note that it is enabled by default.
Windows: Tools > Preferences…■

Mac: Wuala > Preferences…■

Select General to make certain that System Integration is enabled.■

http://manuals.lacie.com/_detail/products/wuala-business/features/versioning/system_integration_01a.png?id=en:manuals:wuala-business:printable
http://manuals.lacie.com/_detail/products/wuala-business/features/versioning/system_integration_01b.png?id=en:manuals:wuala-business:printable


Wuala Business: User Manual 95

 

http://manuals.lacie.com/_detail/products/wuala-business/features/versioning/system_integration_02b.png?id=en:manuals:wuala-business:printable


Wuala Business: User Manual 96

VERSIONING

When working within Wuala, Versioning will keep up to 10 versions of a document. In cases when documents
are accidentally revised or edited, users can rest assured that an earlier version is available.

Versioning will keep 10 versions of a document if it falls within one of the two conditions below:
Edited within Wuala.■

Edited within a folder marked for Wuala Sync.■
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Accessing Versioning

Below is an example of a file that has not been edited within Wuala and does not have earlier versions. Right
clicking on the file does not reveal an option to access an earlier version.

Documents that have been edited within Wuala will give you the option to access an earlier version.

 

http://manuals.lacie.com/_detail/products/wuala-business/features/versioning/no_changes_to_doc.png?id=en:manuals:wuala-business:printable
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Versioning and Sync

Wuala versioning and sync work together to make certain that:
The last ten versions of edited documents can be accessed for easy reference.■

Important company data within the group is up to date on everyone's computer.■

Versioning requires that documents are opened and edited within Wuala. With Sync, files kept on a local sync
folder are also stored and updated to its Wuala folder. Therefore, users are free to edit a document from their
local sync folder knowing that the last 10 versions will be available on the equivalent Wuala sync folder. See the
screenshot below as an example:

The file has been revised and earlier versions are available on
Wuala
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MULTIPLE BUSINESS GROUPS

A single Wuala Business Code allows administrators to create up to five groups on Wuala. Each group can have
up to five users.

Please note that:
The administrator always counts as one of the users.■

Each new user invited to a Business Group counts as one of the five, even if that user is already a member of■

another Business Group.
The 100GB will be shared by all Groups within Company storage.■

Additional storage and users per group may be added to a Wuala Business Code at any time by clicking on the■

Manage link on the bottom right of the Wuala window. You will be directed to a link in the Manage >
Storage. Click on Get More to be directed to Buy Wuala Business.

 

http://www.wuala.com/business/buy
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Adding one or more groups

Right click on your Company name to select Add Business Group…1.

In the Add Business Group window, enter the name of the new Group then click Add.2.

The new group is ready to use. Invite members just as you did for the first group.3.
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TIME TRAVEL

Wuala gives you the option to move back in time to view folders and files as they looked days or weeks before.
To use Time Travel:

Reveal the slider by going to View > Show Time Travel.1.

Move the slider to the left to go back in time.2.
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GETTING HELP

If you are having problems with your LaCie product, consult the table below for a list of available resources.

Order Source Description Location

1
Quick
Install
Guide

Concise steps to
follow for getting your
product up and
running

Either a printed leaflet or accessory box and included in the
product box, or download PDF from the product page

2 Support
Pages

Includes interactive
troubleshooting
topics for most
common problems

www.lacie.com/support/, select your product, then click the
“Troubleshooting” tab

3 User
Manual

Includes common
troubleshooting
topics

See Troubleshooting Topics below

4 Customer
Support

Create an account on
lacie.com, register
your product, and fill
out a support ticket

Create an account here:
www.lacie.com/us/mystuff/login.htm?logout&rtn=mystuff

Note: LaCie is dedicated to providing high quality products that enrich the lives of our customers. To help
LaCie offer the best customer support, we encourage you to create an account and register your product at
www.lacie.com/us/mystuff/login.htm? logout&rtn=mystuff. You can give us important feedback as well as
receive updated information on your LaCie device.

 

http://www.lacie.com/support/
https://www.lacie.com/us/mystuff/login.htm?logout&rtn=mystuff
http://www.lacie.com/us/mystuff/login.htm? logout&rtn=mystuff
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TROUBLESHOOTING TOPICS

Note: Interactive troubleshooting, a highly effective way to resolve problems with your product, is available
from www.lacie.com/support/. Select your product, then click the “Troubleshooting” tab.

File transfers to and from Wuala are too slow.

Q: What type of connection to the Internet do you have?

A: Upload and download speeds to Wuala will vary depending upon the type of network in your office or home.
Please check with your network provider or system administrator to determine how best to speed up your
connection to the internet.

Wuala Accounts for each member of the team.

Q: Why does each member of a group have to create a new account on Wuala?

A: For the moment, it is necessary to maintain this important part of joining a group. In addition to joining the
group, each member of the team receives 5GB of personal online storage on Wuala.

Groups and users per Wuala Business Code

Q: How many groups and users can I add with my Wuala Business Code?

A: An administrator can add up to five groups with five users per group. All groups will share the 100GB that
comes with the Wuala Business Code.

Q: Can I add more storage and users?

A: Additional storage and users may be purchased by right clicking on the group to choose Manage Group. The
Storage tab includes the link Get more members or storage. Clicking on the link will direct you to purchase
options. You may also click here. Please note that buying new users will enable you to invite more users per
group. For example, a starter code gives you five users per group. Purchasing an additional five users will give
you ten users per group.

Users and folders

Q: Can I limit rights to a folders by user(s)?

http://www.lacie.com/support/
http://www.wuala.com/en/business/buy
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A: At the moment, all folders in the group are available to all members in the group. However, folders created in
the user's personal account may only be viewed by the user.
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Inviting Members

Q: Who can invite members to join the group?

A: By default, members can be invited by Administrators and Moderators. Rights for inviting members can be
adjusted in the Manage Group window. Choose the Roles tab to give Members and Moderators the right to
invite new members. You may also deselect the option if you prefer that the administrator is the only person
with the right to send invitations to join.

Sharing Files by Weblink

Q: How do I share specific files or folders with people who are not members of the group?

A: Please see Share.

Backup

Q: Can I backup data from my computer to the group storage?

A: At the moment, backups can only go to a Wuala personal account.

Versioning and File Location

Q: Can I see earlier versions of files stored on my internal hard drive?

A: Versioning works for files that are opened and edited in Wuala. Versioning is also available for files that are
stored within sync folders, no matter if the changes occur on the local disk or on Wuala.

http://manuals.lacie.com/en/manuals/wuala-business/wuala-features-share
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